
V2 Mixer “X” or “Q”

Version 2 software has a full digital mixer which uses the powerful Motorola
56301 DSP chip (Digital Signal Processor) on the SSAC-1 Accelerator Card
installed in your unit. The mixer has a completely user-definable channel
structure and routing and it allows real-time ‘plug-in’ effects and EQs to be
used. You can easily create and save your own mixes and the entire
configuration of the mixer plus all of the parameter settings are saved in the
mixer file, so it is truly ‘total recall’.

Each channel can have any number of real-time processes running (e.g. EQ,
compressor, reverb etc.) limited only by the available DSP processing power.
In fact, you can have as many mixing channels as you need (up to 48
approx.), and there are 16 internal busses (per unit) to send signals to internal
real-time effects, with 99 selectable fader and solo groups. You can also use
any of the 10 inputs and 12 outputs of the system as sends/returns to external
effects units, while mixing tracks from your arrangement.

Note: The mixer is completely separate to the arrangement of audio Parts in the
arrange window and so initially, without first loading a mixer file and entering
the V2 mixer password, you will not hear any audio.

V2 Mixer Password

You will need to enter a V2 Mixer password in the Options menu before use of
the mixer is activated. The individual password for your system can be
obtained from Soundscape Digital Technology or from your local distributor
and is free of charge for users who purchased their system prior to 1997 and
have upgraded with the SSAC-1. Users who have upgraded from the
SSHDR1-FS system should be issued a password with the SSAC-1, as it is
included in the cost of the upgrade.

Loading and Saving Mixer Configurations

Under the File menu you will find New Mix, Open Mix, Save Mix and
Save Mix As. Mixer files can be saved to the PC or to the SDisk, and can
be opened from the SDisk by double-clicking on an SFile that is
identified with a mixer icon.

Mixers are currently not loaded automatically when you load an arrangement,
so for easy identification, you should use a similar name to the arrangement
when saving the mixer file.

Select Open Mix and load ‘mix1.MIX’ from the Mix folder.
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This 12 track example mixer is set to mix all tracks to SSHDR1 outputs 3/4, so
connect a stereo lead from outputs 3/4 to your amplifier, powered monitors or
to a stereo input on your mixing console.

Mixer Concepts

The key to understanding the mixer is simple: “you can have virtually any type
of mixer that you want” provided that you do not exceed available DSP
processing power. The number of channels, EQs, sends or return channels,
peakmeters or faders and their positions in the mixer are completely
user-defined. In fact, every part of the mixer is a plug-in element, just like a
plug-in DSP effects algorithm. The only parameters that are fixed are that
there are 16 internal audio busses per SSAC-1 (i.e. per unit) and there are a
maximum of 10 inputs and 12 outputs per unit.

Virtual Mixer Channels and DSP Processing Power

The mixer can have ‘virtual’ channels or elements that are muted (i.e. turned
off) and unlike a fixed digital mixer, in Soundscape these do not consume
processing power from the DSP. This means that you can construct a mixer
with duplicated channels having different parameter settings, for easy A/B
comparison. Or, you can have one that has far more processing requirement
that the DSP(s) can provide, but with just the elements that you need
activated. This way, if you need to use more effects than available DSP power
allows, you can adjust an effect in real time, record the output to a new track,
or use the Mixdown tool and then mute the real-time effect to save
processing power for other channels.

Note: Pressing the BP button (Bypass) for an element does not reduce the DSP
processing power, as the element is still instantly available. Only muting the
element with the Mute tool will reduce the DSP power used.

Each element consumes a certain percentage of DSP resources and the
overall percentage for processing (P) and memory (M) is shown in the caption
bar at the top of the mixer page. For example, a single channel is around
(P)1.1% (M)1.4%, the 2 band mono EQ is (P)2.5% (M)1.1%, a mono peakmeter
is (P)0.3% (M)0.3% etc. More complicated effects take more DSP power, so
for example, the mono Chorus/Flanger from the Audio Toolbox plug-in takes
(P)5.6% (M)2.1%. If you mute an element, you will see a reduction in the
processing power used, as long as there is no 'masking' taking place, as
described below.

The DSP processing power that is shown as being used for each element is the
percentage of the DSP resources used by the worst case parameter for the
algorithm. In reality, there are several parameters that are important to the
DSP, like processing time, program and memory requirement etc. This means
that if two different elements are combined, the overall DSP percentage
required may be less than just adding the percentage for each (i.e. one
element may need more memory and the other may take more processing

2 Table of Contents

SSEditor V2.02a



time, but with less
memory used). One
algorithm is then
'masking' the power
requirement for the
other.

With multiple units,
the total percentage
shown is for the
individual DSP that is
most utilised, and
there may be much
more power still
available from the
other DSP(s).

Basic Hierarchy

This diagram simply
shows how a signal
moves through a
basic stereo input
channel. The input
for a channel can
start as either a
signal via the TDIF,
analogue or
AES/EBU or S/PDIF
digital inputs, or it
can be internally
sent from another
mixer channel on
one of the sixteen
‘busses’ from the
channel’s output or from an inserted send. Once the signal is in the channel, it
can be mixed with a track output, equalized, level adjusted, peak monitored,
delayed, sent to another channel or output and processed by one of the
available ‘plug-ins’. The fixed PPM meters are pre-fader so they will show a
signal even if the fader is all the way down or if the channel output is muted.
Any changes in level as a result of an inserted fader or EQ will be shown by the
fixed PPMs.

Viewing the Mixer

You can view a Full size mixer by pressing ‘X’ on your keyboard or a Small
mixer by pressing ‘Q’. Both can also be selected under the View menu.
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PPM (pre fader)

Pan/Balance

Fader

Output Assignment

IN TD1-2 U1
IN TD3-4 U1
IN TD5-6 U1
IN TD7-8 U1
IN 1-2 U1

BUS 1-2
BUS 3-4
BUS 5-6
BUS 7-8
BUS 9-10
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BUS 15-16

OUT TD1-2 U1
OUT TD3-4 U1
OUT TD5-6 U1
OUT TD7-8 U1
OUT 1-2 U1
OUT 3-4 U1

BUS 1-2
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BUS 9-10
BUS 11-12
BUS 13-14
BUS 15-16

Track

2 Band EQ

Fader

Sample Delay Line

Peakmeter

Send Pre/Post

Chorus/Flanger

Dynamics

User Definable



With 800x600 screen resolution, Full view allows 8 channels to be viewed and
with Small view this is increased to 13 channels. When using Small view, there
may be some parameters of the elements that cannot be viewed or adjusted
until you double-click on the element to display a pop-up window for that
element. Press the key used to open the mixer again to close the mixer
window.

Note: Once a mixer is opened, it will continue working even if you close the window.

Most of the elements have some kind of pop-up window, especially the
plug-in effects, which have more parameters than can be displayed in the
mixer channel and usually will have graphic displays. The effects and EQs also
have functions for saving and loading presets from the PC.

The mixer has 128 columns and the scroll bar at the bottom of the mixer
allows you to view these. There is also a selection for having the mixer ‘always
on top’ in the Settings menu.

The mixer below is a basic mixer with two stereo channels bussed to a master
channel and an FX return also bussed to the master channel.

You will notice that only column 1 has an EQ and send assigned to it. This is
an example of putting power where it is needed. The restrictions of a standard
mixing desk have been put into the past. If you want to send an EQ’d signal to
an FX unit... drop an EQ in before the send. If you want a normal signal sent to
the FX unit but want an EQ’d version sent to your master outs... drop an EQ in
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after the send. The flexibility of being able to configure and store/recall mixers
creates an entirely new way of working with digital audio.

Standard Mixer Controls

A mixer channel has several standard controls and buttons:-

M - Mute button for Input or Output of a channel
S - Solo for the channel
Pan/Balance Pan for mono-stereo channels, Balance for stereo channels
C - Centre for pan/balance control
Fader - Output volume for the channel
Meter - Mono/stereo pre-fader peak meter
BP - Bypass
SG - Solo Group (1 - 99)
FG - Fader Group (1 - 99)

Note: Mono in - mono out channels do not have a pan control.

Fader and Solo Groups

There are 99 Fader Groups and 99 Solo Groups, which can be selected for
each mixer channel by clicking with the left or right mouse buttons on the FG
or SG values to the left of each fader (they can only be viewed or set when the
Full mixer view is selected). Double clicking on the values allows them to be
entered numerically into a dialogue box.

Different Fader and Solo Groups would be used when you want to change the
levels of some of the mixer channels simultaneously, or for example so that a
‘master’ fader channel is not also muted when you solo one of the other
channels (select a different Solo Group for the ‘master’).

Fader Groups

Using the left mouse button just moves the fader that you click on, but using
the right mouse button moves all faders which have the same Fader Group
value. Moving the group maintains the same relative dB positions between
the faders until any faders reach the maximum or minimum levels. If you
move the group back without releasing the mouse, then the dB relationship
will be unchanged.

Clicking on the Mute button for the output of a mixer channel with the left
mouse button just changes the mute status for that channel. Using the right
mose button toggles the mute status for all channels which have the same
Fader Group value.
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Solo Groups

Using the left mouse button solos the channel that that you click on, muting all
other channels that have the same Solo Group value. The Solo button for the
active channel turns red and all other channels from that Solo Group that are
muted are indicated with a red ‘S’on their Solo buttons.

Clicking with the right mouse button on a channel Solo button, solos all
channels that have the same Fader Group value and mutes channels from all
other Fader Groups. Active channels are indicated with a red Solo button.

Naming Mixer Channels

Mixer channels can be named by double clicking on the box just below the
channel fader (exit Edit mode first).

Track and Input/Output Identification

The TDIF (Tascam Digital Interface) port on the SSAC-1 provides 8 inputs and
outputs and for the first unit, they are named IN TD1-8 U1 and OUT TD1-8 U1.
The main SSHDR1 hardware provides 2 inputs and 4 outputs and these are
named IN 1-2 U1 and OUT 1-4 U1 for the first unit. Identifications for other
units are shown below:-

Unit 1 Unit 2

TDIF

Inputs Outputs

TDIF

Inputs Outputs

IN TD1 U1 OUT TD1 U1 IN TD1 U2 OUT TD1 U2

IN TD2 U1 OUT TD2 U1 IN TD2 U2 OUT TD2 U2

IN TD3 U1 OUT TD3 U1 IN TD3 U2 OUT TD3 U2

IN TD4 U1 OUT TD4 U1 IN TD4 U2 OUT TD4 U2

IN TD5 U1 OUT TD5 U1 IN TD5 U2 OUT TD5 U2

IN TD6 U1 OUT TD6 U1 IN TD6 U2 OUT TD6 U2

IN TD7 U1 OUT TD7 U1 IN TD7 U2 OUT TD7 U2

IN TD8 U1 OUT TD8 U1 IN TD8 U2 OUT TD8 U2

IN 1 U1 OUT 1 U1 IN 1 U2 OUT 1 U2

IN 2 U1 OUT 2 U1 IN 2 U2 OUT 2 U2

OUT 3 U1 OUT 3 U2

OUT 4 U1 OUT 4 U2
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Unit 3 Unit 4

TDIF

Inputs Outputs

TDIF

Inputs Outputs

IN TD1 U3 OUT TD1 U3 IN TD1 U4 OUT TD1 U4

IN TD2 U3 OUT TD2 U3 IN TD2 U4 OUT TD2 U4

IN TD3 U3 OUT TD3 U3 IN TD3 U4 OUT TD3 U4

IN TD4 U3 OUT TD4 U3 IN TD4 U4 OUT TD4 U4

IN TD5 U3 OUT TD5 U3 IN TD5 U4 OUT TD5 U4

IN TD6 U3 OUT TD6 U3 IN TD6 U4 OUT TD6 U4

IN TD7 U3 OUT TD7 U3 IN TD7 U4 OUT TD7 U4

IN TD8 U3 OUT TD8 U3 IN TD8 U4 OUT TD8 U4

IN 1 U3 OUT 1 U3 IN 1 U4 OUT 1 U4

IN 2 U3 OUT 2 U3 IN 2 U4 OUT 2 U4

OUT 3 U3 OUT 3 U4

OUT 4 U3 OUT 4 U4

Creating/Editing a Mixer

To create a mixer, first select New Mix from the File menu and you will see a
completely blank mixer page, with an EDIT button at the bottom right (you can
also edit previously created mixer files). Click on the edit button (or press ‘E’
on the keyboard) to allow the mixer to be edited. It’s always quicker to
understand the mixer if you have a specific routing/mixing configuration that
you need to use and you set out to create it.

Six tools are currently active for mixer editing:-

Create Tool - Used for adding new mixer channels or elements

Loudspeaker Tool - Used for modifying elements or routing

Mute Tool - Used for muting elements or complete channels

Move Tool - Used for moving elements or complete channels

Delete Tool - Used to delete elements or complete channels

Info Tool - Used to display information about mixer elements

Mixer 7



Placing a New Mixer Channel

Select the Record tool and click anywhere in the mixer page to place a new
channel. If you have two or more units in your system, you have to choose the
unit (i.e. the DSP) that the mixer channel will be assigned to. Six types of Mixer
channel elements are currently available, all with pre-fader metering (one
meter where the channel has a mono signal path, and two meters where it is
stereo). You can also select EPP (Equal Power Panning) mode for the outputs :-

The mono in - mono out and stereo in - stereo out channels are simple to
understand, but for the other cases, there are some rules that the system uses.

For mono in - mono to stereo out, the signal is split into stereo at the pan
control and the signal path through the channel is mono.

For mono in - stereo out, the input is mono, but the channel is actually stereo
(there are two meters). This type of channel would be used when you want to
use a stereo effect on a mono source (e.g. a mono to stereo chorus or
reverb). In fact, if you use this channel element without a mono to stereo
process inserted in the channel, then the right signal path will not be
connected at the channel output.

For stereo in - mono out, only the left side of the stereo input will be
connected through the channel.
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For stereo in - mono to stereo out, only the left side of the stereo input is
connected through the channel, but it splits into stereo at the pan control.

The channel has input(s) and output(s) and these can be set to use 10 external
ins and 12 outs or the 16 internal busses. Select the loudspeaker tool (modifies
routing when in EDIT mode) and click on the input or output label to see a
menu of possible routing options.

There is no restriction in how you use the inputs, outputs or busses, and every
signal routed to an output or bus is mixed in equal proportion (after the output
or send fader). For instance, you could have 10 channels with IN 1-2 U1 (or Bus
1&2) as the input, and Bus 3&4 as the output routing. You could then use
different EQ settings to split the signal, process it with different effects (e.g. for a
multiband compressor) and recombine the signals at Bus 3&4. You are even
able to select the same bus as the input and output of a channel, but be
careful as you can have digital feedback this way !

Take care when you mix several channels directly to external outputs, as with
the pre-fader metering, it is not possible to view the output signal in order to
check if the level overloads. It’s best to route the channel outputs to a stereo
bus and then place an additional channel that has the stereo bus as the input
and the channel output routed to two of the outputs. This way the metering for
the mixed signal on the bus is shown and you also have a master fader.

Understanding the Signal Path

The diagram on the opposite page shows an exploded view of how routing
works in the mixer. Column 1 (Drums) has it’s inputs muted so the signal starts
with recorded Tracks 1+2. The signal is then EQ’d before it is sent to physical
outputs 1+2 of Unit 1 (OUT 1-2 U1) for external processing by the Multi FX. The
EQ’d signal carries on through the peak meters and the fader. The signal is
then sent out to BUS 1-2 where it is combined with Tracks 3+4 as well as the
processed return from the external Multi FX. As the Master Out column has BUS
1-2 as it’s inputs, all the signals arrive mixed and the fader becomes the
master level. The signal is then routed to outputs 3+4 of Unit 1 (OUT 3-4 U1).
As the Multi FX outputs are hooked up to Unit 1’s inputs, unmuting column 1’s
inputs could cause a feedback loop. Unmuting column 2’s inputs would mix
the returns from the Multi FX with Tracks 3+4 and would double level of the
signal from the Multi FX.
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Step by Step Mixer Channel

1 Under the File menu select New Mix. You will get a completely blank mixer in
EDIT mode as pictured below:-

2 Using the Record tool,
click on a column and
select the type of
channel you require.
We have opted for
Stereo Input - Stereo
Output on Unit 1. The
EPP options select
Equal Power Panning
channels, so as the
pan control is moved
to one side, the level
for that side gradually
increases by up to 3dB
to compensate for the
overall loss of power
from the other side.
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3 A standard mixing channel will appear with the default inputs and outputs, a
pan/balance slider, pre fade peak meters and a channel fader. There is also
a blank space at the bottom of the column to name the channel.

4 Click anywhere
within the blank
area of the
channel. You will
see the drop
down menu for
selecting the
mixer elements.
Selecting a
stereo track will
insert the next
available tracks.
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5 As there are no tracks already selected, it will default to tracks 1+2.

6 Next, click under the
tracks and select EQ
2-Band Stereo.
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7 The EQ module will now be displayed under the assigned tracks. While you
are in EDIT mode it is possible to move the modules using the Move tool. It is
also possible to move the entire channel to another column.

Placing Mixer Elements in the Mixer Channel

Click with the Create tool in the mixer channel to display a menu of available
mixer elements. Select the one that you need and it will be placed at the
mouse position in the channel. To change the settings, you must first exit EDIT
mode by pressing the ‘E’ key or clicking on the EDIT button. You cannot
overlap mixer elements, so if you do not have enough room in the channel to
place an element, try increasing the vertical size of the mixer window first.
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Signal Routing in the Mixer Channel

The signal routing is always from the top to the bottom of a channel, so for
instance, if you place a Track insert below an EQ, this is the position at which
audio will be recorded or played back (i.e. EQ will be recorded to disk).

Track Inserts

You can place Track inserts anywhere in a channel and you can place more
than one Track insert for the same track, so that with the Mute tool (in Edit
mode), you can easily change the insert point for playback or recording, by
selecting which one is active.

Track Insert - Options

When you have placed a Track insert, there are two options for determining
the mixing or routing between the track playback and the channel input
signal. The options can be set by double clicking on the Track insert element
(exit Edit mode first) to pop up a dialogue box.

The default setting allows the input signal for the channel to be monitored at
the channel output only when a track is armed for recording, but only when
playback is stopped.

If punch-in on the left locator is selected and you press record, while the play
locator is before the left locator (where actual recording will start), you will hear
the track output, but not the input signal. At the left locator, where recording
starts, the input signal will be switched through, so you hear what is now being
recorded. For normal recording, you will hear the input when record is pressed.

The second option is that the channel input signal is always mixed with the
track output and so you can always hear the input. In this mode you have to
remember to mute the input when mixing your recorded tracks, as otherwise,
any noise at the inputs from external signals will be included in the mix. If you
place several track inserts on the same channel, you should select this option,
so that all tracks are mixed together.

In both cases, when recording is armed and you have pressed the Record
button, the track insert element shows a black record ready indicator which
changes to red when the recording starts. In play mode, the track insert shows
the black triangular ‘play’ symbol.
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Using the 16 Internal Busses

The mixer has 16 internal digital busses per DSP (i.e. for each unit’s SSAC-1
card). These can be used to distribute or group signals that are to be sent to
an internal effects process or a master fader. Any channel output or send
element can be routed to a bus and the input for a channel can also be a
bus instead of an external input. A bus can be assigned for the input signal for
as many channels as you need, allowing easy signal distribution in the mixer.

Send Elements

The Send element allows a signal to be sent to external outputs or to the
busses. Double-click on the send element to select whether the send level is
pre-fader or post-fader.

Pre-fader sends are independent of the output fader setting, but post-fader
sends apply the same output fader gain/attenuation to the send level (after
the send fader). Send elements can be mono, mono to stereo or stereo, the
mono to stereo send having a pan control and the stereo send having a
balance control.

More than one send can be placed per mixer channel, for instance, if you
need to route some of the signal to two different effects.

To use the Sends as auxiliary sends/returns to external effects units, set the
routing (using the Loudspeaker tool) to use the external outputs. Then place a
new mixer channel for the return signal, with the input routed to the external
inputs. If you want to use internal DSP effects, then route the Send to a bus,
and place a new mixer channel with the bus as the input and the place the
required DSP effect in the channel.

Equalisers - EQ

The EQ’s are fully parametric, allowing bandpass or notch filters with
variable Q (bandwidth), cut and boost and centre frequency. You
can place as many EQ's as you need in a mixer channel and all will
be active simultaneously (assuming that there is enough DSP power).

If you are interested in the technical definition of Q, it comes from the
parameter that is used to specify the Quality Factor (Q) of an inductor (coil),
that in a passive filter determines how selective (narrow) the filter is. High Q,
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means high quality and therefore a narrow filter. The Q factor value is arrived
at by dividing the centre frequency by the bandwidth of the filter.

If you are used to using 'octaves' instead of Q for setting an EQ, then as the
'octave' value is the bandwidth of the filter compared to the centre frequency,
then 2 octaves means that the bandwidth is twice the centre frequency and
hence it has a Q of 0.5.

The EQs can be adjusted in real-time by clicking (and holding) with the left or
right mouse buttons on the EQ parameters in the mixer channel. If you hold
down both mouse buttons the EQ parameters can be changed more quickly,
the direction of the change is determined by the mouse button pressed first.
Double clicking on a parameter pops up a dialogue box where the value can
be entered directly.

The Mono 2 Band EQ element has two separate fully parametric sections and
for the Stereo 2 Band EQ, there are 4 active EQ’s linked for two bands on the
left and right channels.

Note: In the Small view of the mixer it is not possible to view the second EQ band. To

view this, change to the Full mixer view (press ‘X’ on the keyboard).

Double-click on an EQ element (in the caption bar) to display the EQ pop-up
window. The response of the EQ is shown in the curve display and you can
use faders to adjust the parameters rapidly.

You can open multiple EQ windows, so for identifying which EQ elements the
pop-up window is connected to, the mixer channel and element numbers are
shown at the top.

To save the current EQ settings in a file, click on the Save button, or select
Save from the menu.
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Sample Delay Line

The Sample Delay element can be used to equalise time delays in the mixer
or AD/DA converters (SSHDR1 and SS8IO-1 have different delays, phase and
levels) or can be used to provide phase inversion in the signal path.

It can delay a signal from 0 - 255 samples in order to adjust the delay to null a
signal due to different levels, phase, frequency spectrum etc... depending on
the actual plug-in function. Presently, the Bypass button for plug-ins keeps the
same overall delay as the active plug-in. This may not be possible with other
plug-ins, hence the necessity for the Sample Delay Line. EQs always change
the delay but are frequency dependent as in a normal analogue console.

$ Of course a bit of experimentation with the Sample Delay Line will provide for
some creative results. If you split a stereo pair into two tracks, you can drop a
mono Sample Delay Line on one of the tracks mixer channels and create a
wider stereo image by delaying one side of the stereo pair. Phase inverting
the delayed signal can also add extra width, but may cause mono
cancellation or phasing.

Chorus/ Flanger

The chorus/flanger “plug-in” is only available if you have the Audio Toolbox
Option. (See the Audio Toolbox chapter)

Dynamics

The dynamics “plug-in” is only available if you have the Audio Toolbox Option.
(See the Audio Toolbox chapter)

Delay

The delay “plug-in” is only available if you have the Audio Toolbox Option.
(See the Audio Toolbox chapter)

TC Reverb

The TC Reverb “plug-in” is only available if you have the TC Reverb Option.

WM Reverb

The WM Reverb “plug-in” is only available if you have the WM Reverb Option.
(See the WM Reverb chapter)
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